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0BInstallation 

1. Q: What is the correct installation folder on Windows 64-bit systems?  

 A: Because Windows 64-bit operating systems do not support the .MDB database 
files used by SLP-V, the program must be installed in the 32-bit program folder.   

The folder is Local Disk (C:) \ Program Files (x86) \ ishida \ SLP-V. 

See items #1 and #2 in Initial Setup & Setup Utility for additional 64-bit 
information. 

2. Q: Does SLP-V work with Windows Home (XP, Vista, 7) editions? 

 A: SLP-V should not be installed on any Windows Home version OS.  Isolated 
problems have been reported with SLP-V running Windows Home editions.  In all 
cases upgrading to Windows XP Professional resulted in normal operation. 

3. Q: Which version of Microsoft ® .NET Framework is required by SLP-V? 

 A: Different versions of.NET Framework are required based on the version of SLP-V. 

SLP-V version 3.x uses .Net Framework 3.5, SP1 

Notes:  
 Earlier versions of SLP-V (2.x) required .Net Framework 1.1, SP1. 

 The installation CD prompts to install the required version if it is not found on 
the computer.  

 Windows 7 computers come with .Net Framework 3.5, SP1 installed. 

4. Q: Is it possible to install SLP-V and SLP-V Lite on the same computer? 

 

 

 

 

 

A: No, both programs share the same underlying files.  The first program will be 
detected when the second program is installed and the process will abort.  
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5. Q: What would be the cause of the error messages "Unable to connect to server" 
and "Database open error. Database not found or corrupted" when starting 
SLP-V after initial installation? 

 A: Both cases may occur when required support programs do not install correctly.  
SLP-V requires the following software to be installed: 

Microsoft Windows .NET Framework 3.5., Microsoft Data Access Components 
(MDAC), and Microsoft Internet Explorer 5.5 or later. 

Note: .NET Framework and MDAC are installed from the SLP-V installation CD. 

6. Q: What happens if a valid license file is not supplied during installation? 

 A: If the license file is not supplied SLP-V will install and run as a demo version.   

See item #7 below for more details.  

7. Q: Is it possible to upgrade a demo version of SLP-V to a full version by loading a 
valid license file? 

 A: To upgrade a demo version to a fully licensed version SLP-V must be 
uninstalled and reinstalled with the license. 

Notes: 
 If installing the same version of SLP-V, save the Setup File and reload it after 

the reinstallation is complete. 
 If installing the same version, there is no need to delete the SLP-V folder in 

Program Files as required during an upgrade.  

8. Q: Where is the license file saved? 

 A: In the SLP-V main folder under Program Files, Ishida. 

1BInitial Setup & Setup Utility 

1. Q: On a 64-bit Windows OS why is "Unable to connect to server" displayed when 
starting the program for the first time? 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A: The .MDB database files used by SLP-V are not supported by 64-bit Windows 
operating systems.  SLP-V must run under the 32-bit sub system.  Refer to the 
following items to resolve the conflict. 

1. Copy the file Slp.resources from the SLP-V installation folder (should be 
...\Program Files (x86) \ Ishida \ SLP-V) to C: \ WINDOWS \ SYSWOW64. 

Note: C:\WINDOWS\SYSWOW64 only exists in 64-bit versions of Windows. 

2. Create a new folder C: \ Program Files \ ishida \ SLP-V, then copy and paste 
the default data base there: "SlpNet.mdb".  The default database is in the SLP-
V installation folder. 

Note: After making the changes in steps 1 and 2 above, Windows must be 
restarted for the changes to take effect.  

3. When defining the database in the Setup Utility Database Settings, DO NOT 
specify a database file in the Program Files folder. It is good practice to place 
database files in My Documents or if necessary in the Program Files (x86) 
folder.   
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2. Q: Why would the message "Database is corrupted" occur after initial setup on a 
64-bit Windows PC? 

 A: When configuring SLP-V for "Designated Databases" operation, delete the 
unused default database file (SlpNet.mdb) to avoid this problem. 

When SLP-V was configured for "Designated Databases" the customer's database 
file was correctly saved in My Documents.  The default database, however, 
remained first in the list of databases.  At startup SLP-V attempted to link with the 
default database located in the 64-bit Program Files folder.   

Note: See item #1 above, step 3 for more details.  

3. Q: How is the default setup file reloaded? 

 A: If it becomes necessary to restore the default setup file, SLP-V does not need to 
be reinstalled.  Follow the procedure below. 

1. Stop the SLP-V Server on task tray:  
a. Right click the icon 
b. Select Server Status 
c. Select Stop Service. 

2. Go to the SLP-V folder, typically C:\Program Files\Ishida\SLP-V  
3. Locate the "Setup.ser" file and remove it. 
4. Go to C:\Program Files\Ishida\SLP-V\SetupFile and copy "Usa.set" and paste it 

in C:\Program Files\Ishida\SLP-V. 
5. Rename the "Usa.set" file as "Setup.ser". 
6. Start the SLP-V Server on the task tray 

a. Right click the icon 
b. Select Server Status 
c. Select Start Service. 

7. SLP-V will now run with the default settings.  Open the Setup Utility to 
reconfigure. 

4. Q: Is it possible to selectively reload portions of the SLP-V setup file? 

 A: Individual configuration settings may be saved and reloaded.  The procedure to 
save the settings is listed below.  

a. Open SLP-V Setup Utility program. 
b. In the Configuration menu select General Settings. 
c. Select the Supported Functions tab. 
d. Under UGeneral Operations U, enable Advanced Configuration Settings. 
e. Click OK. 
f. Close and reopen the Setup Utility program. 
g. In the Configuration menu, select Save Selected Setup Data to File. 
h. Click Browse and create the .SIT file. 
i. Select the desired configuration settings and click Save to File.  

5. Q: What is the size and file type of the image assigned to the SLP-V main menu. 

 A: The logo image should be 115 x 125 pixels or smaller.  Both.BMP and.JPG file 
formats are supported.  The store's logo can be assigned via the Setup Utility, UI 
Settings, Logo Setting (lower, left).  
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2BUpgrade from SLP 3.2x 

1. Q: Is it possible to import a ScaleLink Pro 3.2x database file into SLP-V?  

 A: A ScaleLink Pro 3.2x .MDB database file can be imported directly into SLP-V by 
using the Database Utilities feature in the SLP-V File menu.  The option 
"Restore/Load Main Database File" is used to convert the old database to the 
SLP-V format. 

IMPORTANT: Performing this operation will overwrite all data in the SLP-V 
database.  This includes label formats, keyboards, images, etc.  
This operation should only be performed with a new, empty SLP-V 
database. 

2. Q: Is it possible to import a ScaleLink Pro 3.2x PLU File into SLP-V without 
losing other SLP-V file data? 

 A: Yes, by using an ASCII text file, the PLU File can be transferred from SLP 3.2x to 
SLP-V.  The requirements are listed below.  Use the Export and Import ASCII Text 
File features in both programs found in the Tools menu.   

Export from SLP 3.27x 
Save file in the following format: 
a. Set File Format = “Comma delimited” 
b. Set Description Text Format = “Ishida format” 

Import to SLP-V 
Select the following import settings: 
a. Set Delimiter = “Comma (CSV)” 
b. Set Description Text Format = “Ishida (incl. control codes)” 

3BCommunication 

1. Q: What causes "Unable to connect to server" and how can it be fixed? 

 A: There are several reasons this may occur.  Refer to the list below.  

a. Confirm the SLP-V Server is running and not being affected by anything 
else on the PC.  The SLP-V Sever icon should always be in the Taskbar on 
the bottom right hand side of the PC screen. 

Right click on this icon and select Server Status.  If the Current Status is 
"Running", click "Stop Service", then click OK.  When the SLP-V Server is 
"‘Stopped", restart it again by clicking "Start Service".  The Current Status 
should return to "Running". 

Note: The Server status can also be checked: Control Panel > Administrative 
Tools > Services.  Confirm the "Slpservice" (which is the SLP-V 
Server) is Started and set to Automatic.  The Service can also be 
started and stopped from here. 

b. Check the Server Status.  If The Server is running then the SLP-V setup file 
may be corrupted. 

i. Check the size of the current setup file "Setup.ser".  The file should be 
800KB or larger.  The standard location is C:\Program Files\Ishida\SLP-V. 

ii. If the Setup file is small, less than 10KB for example, it is corrupted. 
iii. Close the SLP-V Server.  Right click the icon located on the Windows Task 

Tray (lower, right) and select Exit.  The icon will disappear.  If the Server is 
not closed an error will occur when the Setup file is replaced.  
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iv. Locate the latest backup of the Setup file, for example: 
"SetupBackup20110127.ser".  Note the date format is YYYYMMDD.  The 
standard location is C:\Program Files\Ishida\SLP-V\Backup.   

v. Copy and rename the backup file as "Setup.ser". 
vi. Replace the corrupt Setup file with the new renamed backup file. 
vii. Restart the computer and start SLP-V.  

c. Check if Norton Anti-Virus or similar program has quarantined or blocked any 
SLP-V programs.  The server error will occur if the file "slpservice.exe" 
(located in SLP-V folder) is prevented from running.   

d. The .NET Framework program may have a problem.  This would prevent the 
SLP-V Server from running.  Verify .Net Framework 3.5 and SP1 are installed 
(Control Panel Add/Remove Programs).  If the program is installed, it can be 
uninstalled and reinstalled. 

e. The SLP-V Server service may not be running properly.  Use the following 
commands to uninstall and reinstall the SLP-V service manually. 
i. installutil /u slpservice.exe  

then 
ii. installutil  slpservice.exe 

Note: Run these Command Line (CMD) operations from within the SLP-V 
installation folder. 

2. Q: Why doesn't the Scheduler send data to the scales? 

 A: The "Send to scales?" setting is not checked in the Scheduler's Operation 
settings. 

3. Q: Software programs SLP-V and i-Support do not connect but the scale can be 
pinged.  What is preventing the connection? 

 A: Check for and disable any firewall, anti-virus, or other security feature that is 
preventing communication. 

4. Q: During a new installation, one scale has intermittent communications using SLP-V 
and other programs.  When the scale is pinged packets are lost randomly. 

 A: If, by process of elimination, the trouble is linked to the scale, this may be caused 
by network or IP Address conflicts.  Change the scale's IP Address to a different, 
available address and re-try communications. 

5. Q: What are the Ishida scale port numbers?  

 A: The Port numbers may be needed to connect with third-party scale management 
software or to pass though company firewall.  The numbers are listed below.  

4031 -- AC-4000 series 
7061 -- BC-4000 series 
5041 -- OMNi-4000 / IP-EMZ 
6051 -- SR-2000a / IL-EMZ / IL-2000SA 
8071 -- Uni-7 series 

6. Q: If the customer’s IT Department requires DHCP configuration, how can the scale's 
static IP Addresses be set? 

 A: For the IT Dept to use DHCP each scale’s MAC Address must be linked to a 
specific IP Address.  This will ensure the DHCP server always assigns the same 
IP Address to the scale. 
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7. Q: Why do SLP-V, i-Support, and the Scale Status Monitor continue to show one or 
more scales as connected when the scales are disconnected or shut off? 

 A: If Regular Comms check is off, this is normal until any comms are attempted.  
Then if the scales are off-line the comms status will change.  

Note: Regular Comms Check is set in the Setup Utility, General Settings, Scale 
Comms tab. 

8. Q: If Regular Comms check is off, how and when do SLP-V, i-Support, and the Scale 
Status Monitor check the scale connections? 

 A: Comms status is checked when data is sent to the scales. 
 Example: 
 1. Add PLU #1 and Save 
 2. SLP-V checks the scale status 
 3a. If "enabled", PLU #1 data are sent to the scale. 
 3b. If "disabled", communication is canceled and the data are saved to 

"unsent data".  

4BOperation 

1. Q: Where is the Sale Wizard from ScaleLink Pro? 

 A: Sale Wizard used in ScaleLink Pro 3.2x has been replaced by Batch Price 
Change.  When creating a new batch file be sure to set the Type as "Temporary".  
This will create the second file to send the original prices back to the scales at the 
end of the sale. 

The Batch Price Change feature is located in the Scale Data menu.  On the Batch 
Manager screen select the "Price Change Batches" tab (top).  

Note: The SLP-V Server must be running to send the price changes to the scale.  
The Windows Scheduler is not used by SLP-V.  

2. Q: Why is the PLU Shelf Life (days) value received at the scale one day greater than 
set in SLP-V? 

 A: In SLP-V, the "Add One Day" to the Shelf Life setting affects all scales – it is not a 
scale by scale setting. The setting is configured in the Setup Utility, General 
Settings, General #2 tab: "Add 1 day to Shelf Life…" 

Note: Refer to the appropriate Release Notes or ROM Switch lists for details to 
set the "Add 1 Day to Shelf" in each scale.  

3. Q: Does SLP-V support multi-users?  

 A: Yes, SLP-V supports multi-user as a standard feature.  In a multi-user 
environment, the initial installation is "Client & Server" and all subsequent 
workstations are installed as "Client Only". 

4. Q: Why are Campaign or Price Change buttons shown at the top of the PLU Edit 
window? 

 

 

 

 

 

 

A: These indicate the PLU is included in a Campaign or Price Change batch to 
change the price.  

Note: The Campaign or Price Change batch may be edited by clicking the button. 
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5. Q: Why is a PLU shown in red on the Add/Modify/Delete PLU List screen? 

 A: A PLU shown in red indicates it is Inactive.  Inactive items are deleted from the 
scales but remain in the SLP-V database.  Typically seasonal items are set as 
inactive when not available.  

Note: This feature can be disabled in the Setup Utility under General Settings, 
Supported Functions, General Operations.  

6. Q: Does SLP-V have a backdoor password? 

 A: Yes, the backdoor password is "3wAyhArmony" when the user is "Administrator".  
This password is not available for any other user. 

Note: If the default "Administrator" user has been removed there is no back door 
password.  In this case, refer to the Recovery procedure below. 

Recovery 
If the SLP-V passwords are unknown the program does not need to be reinstalled.  
Instead the default setup can be loaded to allow access.  SLP-V must be then be 
reconfigured. 

See item #3 in Initial Setup & Setup Utility for information about reloading the 
default setup file. 

7. Q: Why are no data displayed in the PLU Totals report? 

 A: There are two common reasons for a lack of totals data. 

1. Totals have not been received from the scales.  In the SLP-V Tools menu, 
select "Receive and Delete Totals from Scales". 

2. No totals were received on the date(s) specified.  SLP-V stores totals on the 
day they are received from the scales into the PC.  If no totals are received on 
a specific day there will be no totals data. 

Note: Reading totals may be automated by adding the operation in the Scheduler 
located in the Tools menu.  

8. Q: Why does communication start but end in an error when receiving totals into 
SLP-V? 

 A: Check if any scale is not connected.  When reading totals, SLP-V reads data from 
each enabled scale.  If a scale is not in use change its status to Disabled. 

9. Q:  Why is some information not imported from an ASCII text file into SLP-V?   

 Why is the message "The import data does not contain a record number field. 
Import aborted." occur? 

 A: Both of the above cases are caused by missing or incorrect file formatting.   

 In the case of missing data, SLP-V does not abort the import process when 
invalid data are encountered.  Bad data are ignored.  If all data for a specific 
field is missing recheck the header (column title) is correctly spelled, is the 
correct case, and has no spaces.  For example if the Barcode value is not 
imported check that the column header is "PosCode".  

 If a "record number" error occurs check that the column header is correctly 
specified as detailed above and that the data exists.  For example if the PLU 
Number is not included in the ASCII text file SLP-V cannot import a PLU file.  

Note: Refer to the technical bulletin "SLP-V Import" for specific details to import 
ASCII text files. 
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10. Q: Why are fields missing in the exported ASCII Text file? 

 A: SLP-V allows the order of the fields to be specified.  Because the Description is 
not forced to be the final field, some fields may be placed after it.  Check the entire 
output line for the "missing" data. 

Note: Click the "Specify Fields to Export" button on the Text Export screen to 
select which fields are included in the text file and their order 

5Bi-Support (Labels) 

1. Q: How is a new field added to a Label Format? 

 A: Click the icon in the left column for the field type to be added.  Then, on an empty 
space of the label, click and drag an area the approximate size of the field. Select 
the Print ID from the list.  Then set the Unit Properties as needed.  

Note: If possible, copy the field from another format.  This saves time and 
ensures the field's properties are set properly.  

Fields may only be copied from labels of the same scale model.  

2. Q: Why isn't a field visible when copied from one format to another? 

 A: Check the following: 

1. Click the "ALL" button at the top of the screen to see every field in all eight 
sub-label views. 

2. If the source label format is larger than the destination format the field may be 
"off" the label.  In the Edit menu, select View Unit List.  Check the end of the 
list for the copied field.  Highlight the field and click Edit.  Change the X and Y 
coordinates to reposition the field.  

3. Q: Why are all the label functions menus shaded out?  

 A: Label functions are available by permission.  If the logged on user does not have 
access to certain features they will be shaded out.  Log on as the Administrator 
to access all functions. 

Note: The UAdministrator should have password protection U to prevent 
unauthorized access to i-Support features.  

4. Q: Is it possible to move multiple fields at once? 

 A: Yes, by using the CTRL key.  Hold down the CTRL key while clicking on the 
desired fields.  On the last field, click and hold then drag the group as needed. 

Alternately, hold down the CTRL key and click on the desired fields.  With the 
CTRL key held down use the Arrow keys to move the group.  

Note: The outline of selected fields changes from solid to dashed lines.  

5. Q:  Can label formats be copied from one scale model to another? 

 Can logos images be copied from one scale model to another? 

 A:  Label formats cannot be copied from one model to another.  This is due to 
differences between models such as maximum label width, supported features, 
etc.  

 Logos may be copied between models.  Note that label images will print at 
slightly different sizes due to different pixel dimensions between models.  
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6Bi-Support (Configuration) 

1. Q: Can an i-View .ABK backup file be opened and used by i-Support? 

 A: Yes, in most cases i-Support can use an i-View backup file to restore a scale. 

Note: i-View cannot read an.ABK file created by i-Support.  It is a good idea to 
segregate and track .ABK files based on the program used created them. 

7BUni-7 and SR-2000a 

1. Q: How can I setup Category keys to link to preset key pages? 

 A: This is a two-step process using SLP-V.  The procedure is similar for the Uni-7 
and SR-2000a but there are some differences which are noted below.  

Uni-7 

a. On the Category Key Page, open a key and set the Key Type as Category 
Selection.  Then, in the Key Data field, enter a unique number. 

Note: Take care not to duplicate the Category numbers.  Some versions of 
SLP-V allow duplicate Uni-7 Category numbers. 

b. Next on a Preset Key Page, open a key and set the Key Type as Group 
Select.  Then, in the Key Data field, enter the desired Category number.   

Note: Sub-Categories are possible on the Uni-7.  Following the instructions in step 
"a" above, place a Category key on a Preset Key page.  Then link to 
another Preset Key page as described in step "b".  

SR-2000a 

a. On the Category Key Page, open a key and set the Key Type as Category 
Selection.  Then, in the Key Data field, enter a unique number. 

b. Next on a Preset Key Page, open a key and set the Key Type as Group 
Select.  Then, in the Key Data field, select the desired Category from the 
pull down menu.   

Note: Only one Group key can be assigned per page.  If "Group" is not 
available in the SLP-V drop down menu then a "Group" key has already 
been assigned on the Preset Key Page. 

2. Q: How do I link more than one Uni-7 or SR-2000a preset page to a category? 

 A: Follow the same procedure as detailed in item #1 above.  If multiple preset pages 
are linked to a category the operator can access them by pressing the PgDn or 
PAGE key.  The preset key pages can be created in any order. 

3. Q: How can I use SR-2000a key images created for the large size keys on smaller 
keys? 

 

 

 

 

 

 

 

 

A: Images on smaller keys are not recommended, as they are usually difficult to 
read.  If images for medium or small size keys are required they must be created 
outside of the SLP-V program.  SLP-V does not have graphics editing capabilities 
to resize the images.  
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4. Q: What are the important points to update Uni-7 firmware from i-Support? 

 A: Several items must be set properly to enable the transfer of firmware files. 

1. The FTP (TCP/IP) Setting for User Name and Password must match between 
the Uni-7 and the SLP-V scale setup. 

 At the Uni-7 the settings are entered in the Communication menu.   
(Setup Menu, Communication, PC COM tab: FTP User and FTP Pass) 

 In SLP-V the FTP settings are entered in the Uni-7 scale setup.   
(Setup Utility, Scale Setup, FTP Settings: User Name and Password) 

Note: In SLP-V, the Uni-7 "Send Folder Path" data is entered only once – 
for the first Uni-7 on the Scale Setup list. 

2. The SLP-V scale setup for "Send Folder path" must point to the "Soft" folder 
containing the scale firmware files. 

3. The "Soft" folder containing the firmware files must not have any sub-folders 
or any zip files. 

4. The firmware download takes approximately 10 minutes as more than 700 
files are sent to the scale.  

5. Q: What are the important points to update SR-2000a firmware from i-Support? 

 A: Several items must be set properly to enable the transfer for firmware files. 

1. The TCP/IP Setting for User Name and Password must match between the 
SR-2000a and the SLP-V scale setup. 

 At the SR-2000a the settings are entered in the System menu.   
(System Menu, Option, Ethernet Card, RF LAN: User Name and Password) 

 In SLP-V the FTP settings are entered in the SR-2000a scale setup.  
(Setup Utility, Scale Setup, FTP Settings: User Name and Password) 

2. The SR-2000a must be set to receive the program update.  At the main menu 
enter 495344 and press the [U/P] button.  

3. The folder containing the firmware files must not have any sub-folders or any 
zip files. 

4. Follow the instructions on the i-Support screens.  Select any file in the 
SR-2000a firmware folder when prompted.  

Notes:  

 The SR-2000a supports remote firmware update by SLP-V from firmware 
version B0499C and C1514.  

 i-Support and SLP-V may lose connection to the SR-2000a after the 
firmware update.  In that case disable then enable the connection to restore 
communication. 

8BAC-4000 & BC-4000 

1. Q: Why does the AC-4000 show error 7 "Address Characters Over Limit"?  The store 
name prints OK but the store address is missing.   

 A: If the Store Name and Address are programmed via SLP-V it is possible to enter 
more than one line for either the Store Name or Store Address.  In most cases, 
however, the label format only has space for one line of Store Name and one line 
of Store Address.  If more than one line is required, the label format must be 
edited with i-Support or i-Label. 
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2. Q: Software programs (SLP-V, i-Support, SLP-V Setup Utility, etc.) do not connect 
but I can ping the scale.  What is preventing the connection? 

 A: Check for and disable any firewall, anti-virus, Virtual Private Network (VPN), or 
other security feature that is preventing communication. 

3. Q: During a new installation, one scale has intermittent communications using 
SLP-V and other programs.  When the scale is pinged packets are lost randomly. 

 A: If, by process of elimination, the trouble is linked to the scale, this may be caused 
by network or IP Address conflicts.  Change the scale's IP Address to a 
different, available address and re-try communications. 

4. Q: Why don't SLP-V, i-Support, SLP-V Setup Utility, etc. connect to my wireless AC-
4000 or BC-4000 even though I can ping the scale? 

 A:  Check for and disable/close any firewall, anti-virus, Virtual Private Network 
(VPN), or other security feature that is preventing data from passing to the 
scale via the RF card. 

 Recheck the IP Address assigned to the Client Bridge (Symbol CB3000).  Be 
sure that the IP Address is not the same as the host scale or any other device 
on the network.  Duplicate addresses prevent or disrupt communications. 

5. Q: In a system with both AC-3000 and AC-4000 scales, why does SLP-V send Extra 
Messages to the 4000 scales but the 3000 scales do not receive them?   

 A: Because the 3000 Series scales only support 99 Extra Messages SLP-V does not 
send the higher numbered messages.  If necessary, all scales may be set to 
receive only 99 messages when using a mix of scale models.  The setting is found 
under the Setup Utility, General Settings, General #1 tab: "No. Extra Msg Digits".  
A value of "2" limits all messages to two digits (1~99).  The default value of "0" 
sends messages based on each scale's capabilities.   

Note: Extra Messages #2 and #3 are not limited because the 3000 Series does 
not support them.  

6. Q: The Store Name and Address character size cannot be changed.  Why isn't the 
character size selected in SLP-V printed on the label? 

 

 

 

 

 

 

 

 

 

 

 

 

 

A: The Store Name and Address character size is set in the label format.  Use 
i-Support (or i-Label) to edit the properties of the label format.  There are two 
alternatives for printing different characters sizes. 

Edit the properties of the Store Name and Store Address fields then: 
 Select Font Size and increase the value.   
 Select Font Size and select Product Name from the list.  This allows SLP-V to 

set the font size. 

Note: Care must be taken to set the field height and width to accommodate the 
font size selected.  Error 7 "Address Characters Over Limit" will result if the 
Store Name and Store Address fields are too small for the character size 
and number of characters.  See item #1 in AC-4000 & BC-4000 for more 
information.  
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9BSLP-V Lite  

1. Q: Why does error message "error loading setup from file" occur? 

 A: The SLP-V Lite Setup file is corrupted.  Copy and rename setup file from the 
Backup folder – see steps below.  One possible cause for a corrupted file may be 
an undersized CPU or insufficient memory as found on low end PCs.  This is not 
always the case and other factors such as a virus, anti-virus software, or other 
software malfunction may contribute. 

a. Close SLP-V Lite. 
b. In the SLP-V Lite folder rename the current setup file “setup.ser” to “xsetup.ser” 

so it will be ignored.  
c. Copy the most recent backup setup file “SetupBack2009xxxx.ser”.  The file is 

located in the Backup folder under SLP-V Lite. 
d. Paste the backup file into the main SLP-V Lite folder and rename it to 

“setup.ser”. 
e. Start SLP-V Lite. 

Note: If the above procedure does not correct the problem, uninstall SLP-V Lite 
and reinstall it.  Configure the scale IP address, etc. as needed.  

2. Q: How can I recover from a message "Database is corrupted"? 

 A: If the program is unable to start because the default database is corrupted there 
are two options: 

1. Replace the damaged database file with a backup.  In the SLP-V folder under 
Program Files, Ishida locate the Backup folder.  Backup versions of the 
database files are stored here.  Locate the most recent version of the corrupted 
file and copy it.  Paste the backup into the folder with the damaged file.  Delete 
the damaged file or change the name by adding an "x" to the name.  Rename 
the backup file to the match the original file name. 

2. Replace the setup file with the default setup file.  This will allow another 
database file to be used instead of the damaged file.  This will also cause loss 
of SLP-V Lite configuration data.  In the SLP-V folder under Program Files, 
Ishida locate the SetupFile folder.  Locate the USA setup file and copy it.  
Paste the default setup file into the main SLP-V program folder.  Delete the 
current setup file ("Setup.ser") or change the file name by adding an "x" to the 
name.  Rename the default setup file to "Setup.ser". 

3. Q: What happens if a valid license file is not supplied during installation? 

 A: SLP-V Lite will not operate without a license file.  A demonstration mode is not 
available.  

4. Q: What is the SLP-V Lite license file name? 

 

 

 

 

 

 

A: During installation, the license file name is "ScaleUserLite.slp".  At installation it 
is renamed to “ScaleUser.slp”.   

Note: Although the license file name becomes the same as the full featured 
SLP-V, the file contents limit it for use with SLP-V Lite only.   
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10BMiscellaneous  

1. Q: Is there any information about the AC-3000 Series scales?  

 A: The following items provide some general information about the AC-3000 Series 
communication. 
1. Any 3000 scale with Ethernet convertor must be set with Node Number = 1. 

2. If two Master scales have the same node number neither will communicate.  

3. For an RS-232 Master scale, verify the scale's comms settings. 

a. Comm Port number 
b. Baud rate 
c. Data format:  

 7 data bits 
 1 stop bit 
 Even parity 

4. Forced Tare is only supported in firmware with 38400 baud upgrade. 

5. Scrolling Message bug.  If more than 94 characters are sent for a scrolling 
message incorrect characters are appended to the end of message. 

 
 
 


